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SUMMARIES OF VIDEOS 

GRADE 10 - 12 

SOLUTIONS DEVELOPMENT – GOOGLE DOCS 

Solutions Development – Google Docs Documents  

1.  Getting Started This lesson looks at what Google docs are how you get access to them and their 

features. Google Docs is a set of productivity tools that have been made freely available to us by 

Google it includes a word processor an Excel type spreadsheet and PowerPoint type functionality. 

There are loads of other applications that you can plug in like project management, drawings or 

document management. 

 

Advantage of Google Docs 

 Free to use 

 Accessible anywhere either on laptop, computer Smartphone if you have internet 
connection 

 They are very easy to share as they are built for collaboration 

 It is backed up by one of the best data clouds there is which means that your data is safe 
even if your hard drive crashed or your computer clashes 

 

To create a Google Doc you must first access Google Drive, this is done by typing drive.google.com 
into your browser and signing in with your Gmail account details which will take you to the Google 
Drive interface. In Drive you go to the big red button called create if you click on it you will get  an 
option of creating a variety of documents choose document which will open a brand new document 
with the same functionality as a Word Document. Once you have added content to your document 
you do not need to save manually, this is done automatically to drive. To go back to your drive click 
on the big blue icon on the left, there you will find your new document which will be saved as 
‘Untitled Document’. There are two ways to name your document. The first way is inside Google 
drive click on the check box next to your document then click on the More button which will give you 
a drop down menu where you will select rename then type in a new name then click ok. You can also 
name the document in the document itself by clicking where the name of the document appears 
which will give you the option of typing in the new name. 
 
There are several  ways to move documents from a shared folder  to your drive; 

 Select the document that you want to move in the ‘Shared with me’ folder then go to the 
more menu and select ‘Move to’ 

 Select the folder button 

 Select the add to my drive button 

 Click on the document hold and drag to My Drive folder  

 Within the document go to file then select ‘Move to’.  
 
To make a copy you go to file in your document then select copy document which will as you if you 
would like to change the name of the document. 
 
You can also upload document to your drive. The first way to do this is by clicking on the upload 
button next the create button this will give you two different option file or folder. The other way is 
by using the drag and drop method where you click on the document then drag it onto Google drive. 
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2.  Working with Text in Documents - a Business Letter 

This is a lesson on how to format a Google document/letter. Learners are taught the following 
format functions; 

• How to copy text; 
o Before you copy you must select the text that you need to copy. Just like in all Microsoft 

Word documents there are a number of ways to select text in a document. Ext can be 
selected by; 
- Using a mouse to click then drag to select all the text you would like to select.  
- Using your keyboard, to do this you position your mouse at the start of the text and use 

the arrows and shift key to select all the lines you need.  
o Once the text has been selected you go to the edit menu and select copy or you can us the 

keyboard shortcut by pressing CTRL and C at the same time. 
• How to paste 

o You fist go to the document where you wish to past the text 
o Then go to the edit menu and select paste or you can use the key board shortcut by 

pressing CTRL and V and the same time. 

 How to align text  
o Select the text you would like to align then go to the More button on your ribbon and 

choose the alignment you would like to use  

 How to make text bold 
o Like in Microsoft word to make text bold you select the text you wish to make bold then 

click on the button with the big letter  

 How change the font of text  
o To do this you go to this menu which will give you all of the available fonts. This fonts are 

little limited but there are additional fonts that you can access by clicking on this                            
which will access fonts online and apply it to your document 

 How to apply colour to text 
o Select text then go to text colour button which will give you a drop down menu where you 

can pick colours 

 How to change font size 

 How to remove highlights 
 

3.  Advanced Formatting Features  

In this lesson we look at advanced formatting features in Google. 

Applying  a Boarder Around a Paragraph 

There is no paragraph boarder feature in Google Docs to apply a boarder. To insert a border one 

must insert a table this is done by going to the insert menu, select a 1x1 table, the table will appear 

in your document and you can now paste your text in the table. Your text will now be in a boarder. 

 

Inserting background colour 

To insert background colour to the boarder go to table menu then select table properties then 

background colour 

 

Spacing  

Like in Microsoft Word you use the line spacing feature to adjust the line spacing. This feature can be 

found in the formatting menu. 

 

Alignment of text  
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To align text select all the text you wish to align then go to the align menu on the tool bar and select 

the type of alignment you wish to apply. The alignment options can also be found in the more menu 

on your toolbar. 

Introducing Indentation 

In Google Docs indentation can be introduced by going to format in paragraph styles where you can 

choose to either increase or decrease indentation. 

 

4.  Final Checks and Print Readiness 

This lesson looks at the number of checks one must do in order to get a document ready for printing. 

These checks include; 

1. Find and replace- if there are any words that you wish to change in your document you can 
use the find and replace tool to change them. This is done by following these simple steps; 

 Go to edit menu and click on find and replace which will open a dialogue box 

 In the dialogue box type in the word you want to find and the word you want to replace 
it with then click on replace. If the word appears more than once you can click on replace 
all. 

2. Spelling errors- Google Docs has spelling check but no grammar check. To correct spelling 
errors you can either retype it or move your cursor over the word and right click it which will 
give you suggestions of the correct spelling, click on it and the spelling error will be 
corrected. 

3. Page numbering- to add page numbers follow these steps; 

 Go to insert and 

 Click on page number which will give you an option of either inserting the numbers at 
the top or bottom of the page pick one and the numbers will appear in your document 

4. Page breaks- a way of forcing an end of a page at a certain point in the document. This can 
be done by ; 

 Put the cursor where you want the page to break 

 Go to insert and select the page break, this will automatically break the page where your 
cursor was and move the text after the cursor to the next page. 

5. Page header- Google docs has preset headers to select from in the styles menu 
 
Once all the checks are done the document can be printed. To print the document you 
Go to file and click on print or click on the shortcut on the menu bar. Once clicked a number of 
options will open on your screen which include; 

 Destination (which printer) 

 Pages you wish to print 

 Number of copies 

 Print in colour of black and white 

 Change margins 

 A choice to use print system dialogue box that comes with your operating systems 
 
When all settings are correct simply click on the print button and the job will go through to the 
printer. 
 

5.  Inserting Images I 

To insert pictures and images into a Google Docs go to insert menu and choose the first option which 
is image this will give you a number of ways to insert the image. These ways include; 

 Upload- if you click on this option you will have to upload the image from your computer 
then press select, the image will then appear in your document. Use the corner handles to 
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scale the image up or down. 

 URL- here you copy and paste a URL of the image you wish to upload then press select the 
image will then appear in your document where you can format it as you wish. 

 Take a snapshot 

 Choose from Your Album 

 Google drive 

 Search 
 

6.  Inserting Images II 

To insert an image follow the following steps go to insert and select drawing which will give you a 
dialogue box to use as a canvas to draw an image. Once you have drawn your image click save and 
close, your image will now be visible in your document. To edit your drawing simply double click on it 
and the canvas will reappear. Use text wrapping to move things around in your document.  
 
To change margins in your Google document use the buttons on your ruler that determine the page 
margins or by going into the page set up menu. In this menu you can also change the page colour. 
 

7. Managing and Sharing your Documents 
In this lesson we look at the use of numbered and bulleted lists. To apply a numbers or bullets to a 
list you first have to select the text then go to more                 where you select either numbered list 
or bulleted list options. Once the list has been created you can create sub points by increasing 
indentation. Indentation can be increased by; 
Going to paragraph styles in the format menu  
Put your cursor where you wish to indent then press the tab key on the keyboard once to indent to 
one sub point press it again and it will create a sub point below the original sub point  
 
If you make a mistake while creating sub points you can correct it by; 

 Clicking on the undo function  

 Going to paragraph styles in the format menu and selecting decrease indent 

 Pressing shift and the tab key on your keyboard which will reverse the direction of the 
tabbing 

 
The numbered and bulleted lists can be modified in a number of ways namely 

 Change the style of the lists by using preset lists 

 Change suffix and prefix that gets applied to bulleted lists by going to the format menu and 
in list options you can edit the prefix and suffix. 
 

8. Inserting and Formatting Tables 
In this lesson we go through how to insert a table into a Google document. Tables are very useful for 
placing text exactly where you want it. Tables can be inserted by going to insert then table menu or 
by using the table menu. You can also insert a table within an existing table. 
 
To make changes to the table go to table properties which can be accessed in the table menu or by 
right clicking in the table. Table properties gives you options to; 

 Change the table boarders 

 Change background colour of the table 

 Change cell padding (the distance between the edge of the table and the text) 

 Align the table 

 Change column width/make column narrower. This can also be done by  moving your cursor 
onto the boarder of the column clicking and dragging  
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Inserting New Rows 
To select a row then go to insert rows go to insert and choose whether you want to insert rows 
above or below the selected cells. 
Deleting Cells 
To delete a row put the cursor on the cell of the row you want to delete then go to the table menu 
and select delete which will delete all the cells in the row. 
 

9. Managing Files and Collaborating 
Document management and collaboration features in Google are looked at in detail in this lesson. 
Google Docs is very Powerful for collaboration because a team of people can work on exactly the 
same document but have their own filling system.  
 
To create a new folder in your drive you click on the create button then select folder which will give 
you a dialogue box to enter the name of your folder which you can assign a colour to. To move files 
to the folder you simply click and drag the files to the folder. Files can also be moved within the 
document. 
 
Google Docs Templates can be accessed in the Google Docs by going to new and selecting from 
templates which opens a brand new browser with the Google Docs template library containing 
templates created by Google and ordinary people. In the library you can select that meets your 
needs. Once you have selected it will be saved as a copy of the template so you will need to change 
the name. Once you are done creating the document you can share with your colleagues for 
collaboration by going to the share button on the right hand corner of your document this will open 
up a dialogue box where you type in the emails of the people you want to share the document with 
and type in a message of what you want them to do with the document and give then rights to edit 
or restrict their rights to edit. Google Docs lets you know when your colleagues are accessing the 
document, you can also chat you your colleagues as you are working on the document. 
 

10. Working with Headers, Footers and Styles 
In this lesson we look at the following functions; 

1. Inserting Page Break 

 Put the cursor where you want the page to break 

 Go to insert and select the page break, this will automatically break the page where your 
cursor was and move the text after the cursor to the next page. 

2. Inserting headers and footers- to insert a header you go to the insert then click on header, 
this will insert a header to your document. The header ends where the grey line is. What you 
type in the header will appear on every page of your document. To insert a footer you follow 
the same process but select Footer instead on Header in the insert menu.  

3. Inserting page numbers- to add page numbers to a document you're editing in Google Docs, 
click the Insert menu and mouse over Page number. From the Page number sub-menu, 
choose where you want the page numbers placed on the page: Top of page or Bottom of 
page. 
 
To insert a page count, click the Insert menu and select Page count. Since you've inserted 
page numbers, the page count will show at the top or bottom of the page, next to the page 
number. If you haven't inserted page numbers, the page count will be inserted where your 
cursor is placed in the document. 

4. Changing line spacing of paragraphs- to format the line spacing in your document you go to 
format then line spacing which will open up a sub menu where you can 

 Increase the line spacing in your paragraph you (for this you select custom spacing) 
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 Add a space after your paragraph  
5. Creating, editing and using preset document styles within a document before uploading it 

as a new Google template  
 

11. Tables of Contents, Anchors and Hyperlinks 
In this lesson we practice some of the functions we have learnt throughout the series. 

 How to insert and update a table of contents- to insert a table of contents put the cursor 
where you want the table to appear then go to insert table of contents which looks at all the 
headings in the document and produces a table of content. The headings in the table of 
contents are links to the part of the document. There is a refresh button next to the table of 
contents that you press to update the table of contents ass you add more content to your 
document this can also be done by right clicking the table of contents and selecting update 
table of contents. To delete of contents right click on the table of contents and select delete 
table of contents in the menu. 

 

 How to include footnotes and bookmarks in a document- footnotes are links to additional 
information that gets placed at the bottom of the document. To insert a footnote put the 
cursor after the text that you wish to add extra information on then go to insert and select 
footnotes. A super script will now appear where the cursor was and insert a footnote at the 
bottom of the page where you insert text that is the footnote.  
 

 Inserting hyperlinks- inserting links is a core function of Google Docs. To insert a link you 
select the word you wish to apply a link to the in insert menu select link which will open a 
dialogue box where you enter the link then click on apply. You can create links within the 
document by using bookmarks. 
 

 Publishing and sharing documents for others to read and collaborate- in this lesson we 
practice the skills we learnt in lesson nine on how to share documents.  
 
Google docs can also be shared to the World Wide Web by publishing the document in the 
file menu. Once the document has been published you can remove the document from the 
Web. 

 

 Review and track changes made and comments inserted to a document by others-  Once 
the document has been shared highlights appear to the text/paragraph that have comments 
from people collaborating on the document. When you click on the comments they appear 
on the right hand side of your document, you can respond to the comments. Once the 
comment has been resolved click on the resolved button which appears on top of the 
comment and the comment will disappear. All the previous comments can be accessed by 
clicking on the comments button. In order to see and track changes made by others you 
must access previous versions of your document. This is done by selecting see revision 
history in the file menu which will make the document read only and you can see all the 
changes made. If you do not like the changes you simply restore previous versions on the 
right hand side of your document. 
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Solutions Development – Google Docs Spreadsheets  

1.  Google Spreadsheet Basics   

Google Spreadsheets are very similar to Microsoft Excel, so the transition between the two should 
be smooth. Spreadsheets are powerful tools to help you manage large amount of data. 
 
To open a new workbook, click on the red button in your Google Drive labelled ‘Create’ and then 
click on ‘Spreadsheet’. A new window will open in your browser with the workbook in it. 
 
Let’s go over some of the basics: 

 To select an entire column, click on the column heading. 

 To select an entire row, click on the row heading. 

 To select multiple cells at once, click and drag your selection, so that it is highlighted. 

 To make the columns wider by place your arrow between A and B and drag to widen. 

 To merge cells, highlight a selection of cells and then click on the drop down menu and select 
‘Merge cells’. 

 Format the appearance of the cell by selecting it and then clicking on ‘Bold’ or ‘Italics’, etc. 

 To wrap the text within a cell, select the cell, click on ‘Format’ and then click on ‘Text wrap’. 
 
Sometime we don’t want to type everything. If there is a predictable pattern to what we’re typing, 
likes days of the week, or months of the year, we can use the ‘AutoFill’ feature. For a numbered list, 
type the number it 1 in a cell and then select it. Place your mouse on the bottom right hand corner of 
the cell until it changes to a + sign. Then click and drag down the column. It will automatically fill in 
the cells you have selected and it is clever enough to change the number on each one.  
 
To delete unwanted rows, click on the row header of the row or rows that you want to delete, then 
right click and select ‘Delete rows’.  
 
You can also add borders from the drop down menu. First select and highlight the selection of cells 
that you want to have a border, or lines, drawn around them. Then click on the drop down menu and 
select the border you want. 
 
To insert a row simply select the row where you want the new row to go. Right click on it and select 
‘Insert row below’. 
 
You can hide rows or columns if they are making your table look to busy. Click on the row header, or 
column header of the information you want to hide, then right click and select ‘Hide rows’. You 
repeat the process to unhide them when you want to. 
 
To rename the workbook, click on the current name in the top left of the window and type in the 

new name.  

 

2.  Data Validation and Simple Formatting 

Before we begin 

 It is important to remember that when you work on the Spreadsheet, you can enter 
formulae to help you calculate many actions, but the formula will work on cell referencing 
and not the data that you type in.  

 It is also important to understand the operations of BODMAS as Google Sheets uses this to 
do calculations. 

 
Data Validation is when you restrict the type of information being entered into a cell. For example, in 
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the column labelled Currency, we only want to accept the ZAR, US$ and Euro. No other currencies 
must be entered. 
 
To do this, first select the affected cell. Then click on ‘Data’ so that the Data Menu drops down, and 
then click on ‘Data Validation’.  

 Firstly it will clarify the cell range you wish to apply this validation to. 

 Then you can choose from a drop down menu some responses. We are going to give it a list 
of data that it can accept:  so click on ‘list of items’ and then type in ZAR, US$ and Euro 

 Then click on ‘Reject input’ for any invalid data. 

 Select the ‘Display in cell button’. 

 Select the ‘Show help button’ and then type in a message to explain what can be input into 
that cell. 

 Click ‘Save’ 
 

On your spreadsheet you will now see a tiny arrow in the selected cell. If you click on the drop down 
arrow you will see the list of items that can be used to input data into that cell. Should anything else 
be typed into that cell, a message will appear to explain why that data is invalid. You can now use 
‘AutoFill’ to select and fill in all the cells that you want to apply this Data Validation to. If you need to 
remove Data Validation from a cell, simply go back to the Data Menu and click on ‘Remove Data 
Validation’.  
 
To change a number to a currency, select the cell with the number already typed into it, navigate to 
‘Format’, then click on ‘Number’ and then on ‘Financial’.  
 
To change a number to a percentage, select the cell with the number already typed into it as a 
decimal, navigate to ‘Format’ and then click on ‘Percentage’. If it’s included two decimal places, use 
the shortcut key to shorten it to no decimal placing.  
 
To apply the same formatting in one cell to another, click on the cell that has the formatting in it, 
then click on the button which has a copy formatting function and then paste it in the cell you want 
the same formatting to apply to. The copy formatting button looks like a paint roller.  
 
A formula is a mathematical expression that you can add into Google Sheets to calculate certain 
values. A function is a pre-set mathematical function, already programmed into Google Sheets, that 
you can use inside your formulae to either add mathematical operators like calculating the sine of an 
angle or to calculate logic to your expressions. 
 
Logic is a built-in function that can be used in the sheet. We use the IF function to return a value 
depending on a logical expression. In this video, we use the IF function to calculate the item cost in 
Rands, if the original cost is in US Dollars. To do this, we have to ask the sheet to first check if the 
cost is in US$ and if it is, to multiply it by the exchange rate found in cell D4.  The formula will then 
look like this:  =IF(C8=“US$”,F8*$D4, F8). This asks the spreadsheet to check if the value of cell C8 is 
US$. If it is, then the spreadsheet is told to multiply the value found in F8 by the value in D4. If the 
value of C8 is not US$, then the value of F8 must just be copied into the cell where the IF function is. 
The dollar sign you see there is a locking device, it freezes the D4 cell to ensure that all calculations 
use the value in that cell, otherwise Auto-fill will use the next cell down. Because once you’ve 
worked out the formula in the first cell you will now use Auto-fill to calculate the rest of the rows in 
that column, instead of doing them one by one. 
 

3.  Simple Calculations and Formulae 

To add a sheet to a workbook, click on the plus symbol on the bottom left of the window. This will 
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automatically add another sheet. To rename the sheet, left click on the arrow next to the sheet 

name and select ‘Rename...’ and type in the new name. 

 

If you want to use a value from another sheet, press ‘=’ and click to the other sheet. Click on the cell 

you’d like to copy and press enter. 

 

If you would like to add the values in a range of cells, use the SUM function. First press ‘=’ and then 

select the SUM function found in the dropdown menu found at the function button which looks like 

this:  Type or select the range of cells you want to add up. The final function should look 

something like this: =SUM(A2:G2) Other functions that can be easily used are AVERAGE, COUNT, 

MAX and MIN. 

 

To do a more unusual or unique calculation, start the formula with ‘=’ and use cell references and 

the following operation symbols: 

 Add + 

 Subtract – 

 Multiply * 

 Divide / 
Remember that Google sheets will use BODMAS to determine the order of operations which should 
be performed, so don’t be scared to use brackets as well. 
 

If you want to continually work with the same range of cells, you can name the range of cells for easy 

reference.  To do this, select the cell/s and navigate to the ‘Data’ menu and click on ‘Named 

ranges...’ A pane will open on the right of the sheet. Click ‘Add a range’. Give the range of cells a 

name that you will easily remember and click ‘Done’. Now whenever you want to use that range of 

cells, you can just type in the chosen name rather than manually selecting the cells.  

 

4.  Nested IF Statements 

In the previous video, we were able to change US$ into Rands (ZAR) by first checking if the currency 

was in US$, and then multiplying it by the exchange rate. In this video, we’re going to nest this 

calculation into another one which will first check if the currency is Euros. To do this, we will need to 

nest the previous IF statement into a new IF statement. 

 

To revise, an IF statement should be set up as follows: 

=IF(logical_expression, value_if_true, value_if_false) 

 

For example = IF(C12=”US$”,F12*B4,F12) tells the spreadsheet that it should first check to see if the 

value of cell C12 is US$. If it is, then it should multiply the value in cell F12 by the value in cell B4. If it 

isn’t, then the spreadsheet should insert the value of F12 into the cell the formula is in. 

 

This formula only checks to see if the currency is in US$. If we want to first check if it’s in Euros, we 

should use the following IF statement: 

=IF(C12=”Euro”, F12*B5,(IF(C12=”US$”,F12*B4,F12)))  

This nested IF statement first asks the spread sheet to check if the value of cell C12 is Euros. If it is 

Euros, then the value in F12 must be multiplied by the value in B5. If it’s not Euros, then the 
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spreadsheet needs to check if the value of C12 is US$. If the value of C12 is US$, then the 

spreadsheet must multiply the value of cell F12 by the value of cell B4 (the US$ exchange rate). If the 

value of C12 is not US$, then the spreadsheet should just copy the value of F12 into the cell where 

the formula is. 

 

Remember, you can use AutoFill to copy the formula into the rest of the column but be sure to 

remember to lock the cells that need it. 

 

5.  Sorting and Filtering Data 

Sorting and filtering data is especially useful for spreadsheets that contain a large amount of data. Of 
course it’s easier to work with the data is the header row stays static. You can freeze the header row 
by navigate to ‘View’ and click on ‘Freeze rows’. Choose the number of rows to freeze. A larger 
border will appear on the frozen row. As you scroll down, you’ll notice that the header row will stay 
on screen. You are also able to freeze columns using the same method. 
 
To sort or filter the data in the spreadsheet, you need select the data you’d like sort or filter. A quick 
way to select everything is to click in the top left corner of the sheet. All of the cells will turn blue to 
indicate that they have been selected. 
 
To sort the data, navigate to ‘Data’ and select ‘Sort’. A new dialogue box will open. Indicate whether 
the data has a header row or not, and select the column that you’d like to sort the data by. You’ll 
also be able to choose whether you want to sort it A to Z or Z to A. Click ‘OK’ and the data will be 
sorted. 
 
To apply a filter, navigate to ‘Data’ and click on ‘Filter’. Dropdown arrows will appear next to each 
heading. Click on anyone of them and you’ll see all of the values represented in each column. To 
filter out results, select only what you want to appear. Filters are useful if you want to apply a 
calculation to only a couple of fields. 
 
This video also discusses how to use the LEN and MID functions. 
 

6.  Advanced Formulae 

This video explains, in detail, how to use the IF, LEFT, VALUE and RIGHT functions.  
 
Using the Data button, select Turn Off Filter. This makes it easier to carry out various functions in the 
spreadsheet. Some examples of the functions covered in this lesson are: 

 =if(left(B44,1)=”E”,B44,”No ID”) – provides a way to check if a piece of data in a  cell meets 
certain criteria, and to give a standard answer if the answer to that query is yes or no. 

 =if(left(B44,1)=”E”(value(right(B44,8)),”No ID”) 

 =if(B44=”PDF”,I44, (left(B44,1)=”E”(value(right(B44,8)),”No ID”))) – a nested IF statement 

 =if(left(B44,2)=“MM”,L44,(if(B44=”PDF”,I44, (left(B44,1)=”E”(value(right(B44,8)),”No ID”))))) 
– a nested IF statement! 

 
The lesson also shows how and why the error #VALUE! occurs.  
 

7. Analysing Data 
If you want to round off a number, select the cell and navigate to ‘Format’, ‘Number’ and click on 
‘Number’ on the menu that appears. 
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The COUNT function will count the number of numerical values in a row or column. COUNTA will 
count the number of alphanumerics (text and/or numbers) in a row or column. 
 
Conditional formatting can be applied to highlight certain results. Select the data you’d like to apply 
conditional formatting to, and navigate to ‘Format’ and ‘Conditional formatting’. A new dialogue box 
will open. Choose what you’d like to format and how you’d like it to appear when formatted. Once 
you are satisfied, click ‘OK’. To remove this formatting, navigate back to this dialogue box and click 
the ‘x’ next to the formatting criteria, then click ‘OK’. 
 
To count the number of specific values, use the COUNTIF function. It allows you to pick the criteria of 
what you want to count. You will be able to use mathematical symbols like <, >, and = to set the 
criteria. 
 
This video also revises the AVERAGE, MIN and MAX functions, and AutoFill. It also explains how and 
why you would use the VLOOKUP function. 
 
To find particular sets of data within the sheet, you can use the short cut CRTL F on your keyboard. 
Type in what you’re looking for and press enter. The search results will be highlighted within the 
spreadsheet. 
 

8. Plotting Graphs 
Google has many more interesting graphs and charts than any other spreadsheet offering. As you set 
up your charts, explore them and use ones that are interesting and display your data in a logical 
manner. 
 
Before you create a chart, you need to copy and paste the data you’d like to use into a separate 
worksheet. Make sure that you paste that data as ‘values’ otherwise old formulas may not work in 
the new sheet. Also, include all the relevant headings. 
 
Select the data for the chart and navigate to ‘Insert’ and then ‘Chart’. A new dialogue box will open 
which allows you to choose what sort of chart you’d like to use. Go through all of the 
recommendations and choose one that suits the data. Navigate to the ‘Customize’ tab to change the 
appearance of the chart. Click ‘Insert’ to insert it into your sheet. 
 
If you click on the dropdown arrow on the top right of the chart, it will give you a variety of options. 
You can do advanced edits, delete the chart, save the chart as an image, publish the chart, copy the 
chart and move it to another sheet. If you hover over the top of the chart, your cursor will change to 
a hand. You will then be able to click and drag the chart to a new location within the spreadsheet. 
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Solutions Development – Google Docs Presentations 

1.  Creating a Basic Presentation  

To create a new presentation, go to your Google Drive and click the big red button which says 

‘CREATE’. You’ll be asked what you want to create, click ‘Google Slides’ and a new tab will open in 

your browser. You’ll immediately be asked what theme you want to use and the size of the slides. 

4x3 is standard slide size for a presentation. Close the window. 

 

The first slide that will pop up is a title slide. To type on the slide, click on one of the place holders 

and type. To add another slide, either click the button with a plus sign on it, or right click on the left 

pane and select ‘New slide’. 

  

To format the text, select it and navigate to the tool bar. Use the buttons to change the font, the size 

of the font, the colour and the style. 

 

To fix a spelling error, right click on the word and select the suggested corrected word. 

 

Paragraphs of text are problematic in a presentation. It’s better to use bullet points that highlight the 

important points. Use key words and short phrases. 

 

To insert an image, click on ‘Insert’ and then ‘Image’.  A new dialogue box will open where you are 

able to choose if you want to insert an image from your Google Drive, upload an image, take a 

snapshot or insert an image using an URL. Click ‘Select’ and the picture will appear on the current 

slide. Use the handles to resize and rotate the picture. Click and drag the picture around the slide to 

reposition it. As you do this, red guidelines will appear to show when the picture is centred or 

aligned to other objects. 

 

Below the slide, there is a note section. This is where a speaker could put all of their notes, to remind 

them on what needs to be said. This space is quite small, so you can increase it by clicking on the top 

bar and dragging it up. 

 

If you’d like to insert text into different places, use a text box. Go to ‘Insert’ and then click on ‘Text 

box’. Then draw it in the desired sport and type the text. This is particularly useful if you’d like to 

attribute a picture to its source on the Internet. 

 

Your presentation will automatically save as you make each change. If you’d like to change the name 

of the presentation, click on the name on the top left and type the new name. 

 

2.  Inserting Videos and Animations and Editing the Presentation Master 

When you have opened your presentation, you will see a preview of all of your slides in the left 

pane. If you want to reorder your slides, just click and drag them into the desired position. 

 

To change the layout of a slide, right click on it and click ‘Apply layout’. Click on one that suits your 

needs. 

 

Any video you insert needs to be online. To insert one, click on ‘Insert’ and then ‘Video’. This will 
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open a new dialogue box which will ask you to either search for a video on YouTube, or to insert a 

video using a URL. Click ‘Select’ and the dialogue box will close. 

 

To change the size and rotation of the video, use the handles. Click and drag the video to reposition 

it and pay attention to the red guidelines. If you would like to centre align the video, you could right 

click on the video and select ‘Center on page’. 

 

To edit the template, you can either navigate to ‘Slide’ and then ‘Edit master’ or you can navigate to 

‘View’ and then to ‘Master’. Both options will take you to the same page. You can make changes to 

the appearance of the template and then click on the close button. The changes will be made to your 

current presentation. 

 

To put a border around a text box, select it and go to the tool bar. Increase the line weighting and 

change the colour using the appropriate buttons. 

 

To animate an object or text, select it and then navigate to ‘View’ and then ‘Animations’. The 

animations pane will open on the right of the screen. Click ‘Add animation’ and you will be presented 

with various options including the type of animation, at what point you want it to animate and what 

length of time the animation will run for. 

 

In the same animations pane, you will be able to change the slide transition. Click on ‘Slide:No 

transition’ and it will display the options, like the type of transition. It also gives you the option to 

apply the transition to all slides. 

 

3.  More Advanced Formatting and Hyperlinks  

To import slides from another presentation, click ‘Insert’ and select ‘Import slides’. A new dialogue 

box will open and display all the presentations saved on your Google Drive. Select the appropriate 

presentation, and click ‘Select’. A new dialogue box will open which displays all of the slides in the 

presentation. Choose the slides you’d like to use and then select whether you’d like to ‘Keep original 

theme’  or not, and click ‘Import slides’. 

 

To insert a hyperlink, select a section of text or an object and navigate to ‘Insert’ and click on ‘Link’. A 

box will open. Copy the URL you’d like to insert in the box and click ‘Close’. 

 

To present the presentation, just click on the ‘Present’ button. 

 

To insert a table, navigate to ‘Insert’ and click on ‘Table’. Select the size of the table and it will appear 

on the slide. You can click and drag it into position. To merge two or more cells together, highlight 

them and right click. Select ‘Merge cells’. You can change the column width or row height, hover 

over the bar until your cursor changes, then click and drag the bar to the desired position.  To change 

the border, highlight the cells and hover over the top right corner until a drop down arrow appears. 

Click on it and make the appropriate selection. You will then be able to make changes to the borders 

using the buttons in the tool bar. 
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4.  Creating Custom Layouts 

To copy a slide, right click on it in the left pane and select ‘Duplicate’. The duplicated slide will appear 

just below the original slide. You can reposition it by clicking and dragging it to the desired position. 

 

Master view allows you to make changes to the template you’re currently working in. To access this 

view, either navigate to ‘Slide’ and then ‘Edit master’ or to ‘View’ and then to ‘Master’. To insert a 

new type of slide, click ‘Insert’ and then ‘New layout’. Add the objects you’d like to appear on this 

new layout. These objects could include shapes and place holders. Click on the close button when 

you’ve completed your new layout and it will automatically be saved and ready to use in your 

presentation. 

 

It is very easy to work with other people on Google Slides. In fact, you can all work on the same 

presentation at the same time. To add a collaborator, click on the ‘Share’ button in the top right and 

add peoples email addresses. You can choose whether you’d like the to be able to edit the 

presentation, to comment on it, or just to view it. To send the invites to collaborate, press ‘Send’. 

 

If you would like to make a comment on a slide for other collaborators to read, select an object or 

some text and navigate to ‘Insert’ and click on ‘Comment’. You will then be able to type in your 

comment. Others will also be able to type replies to the same comment. 

 

To embed your slide show in another blog or website, you need to use an embed code. Go to ‘File’ 

and then click on ‘Publish’. This will open a new dialogue box. Click on ‘Start publishing’ and the 

dialogue box will expand to show you the embed code of the presentation. Copy this code and use it 

on the chosen website or blog.  

 

 

Note: there are no interactive multimedia lessons and no How To’s for this section on Google Docs. 

 


